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ВВЕДЕНИЕ 

 Для выполнения представленных в настоящем методическом ру-
ководстве лабораторных работ предлагается использовать систему 
автоматизированного проектирования Advanced Design System , которая  
предназначена для моделирования аналоговых и цифровых радиоэлек-
тронных устройств и систем широкого класса. Ниже приводится после-
довательность основных команд, ориентированных на сеанс работы с 
программным обеспечением данной САПР. 

1. Запустить программу Advanced Design System. Сгенерируется 
окно главного меню. 

2. Установить режим работы системы - аналоговый, если это не-
обходимо, выполнив команду Tools> Advanced Design System 
Setup>Analog RF Only. Выйти из программы и снова ее запу-
стить. 

3. Создать новый проект - команда File>New Project. 
4. Присвоить имя новому проекту и открыть его. К имени авто-

матически присоединяются символы _prj. 
5. Открыть окно схемного редактора командой File>New Sche-

matic. 
6. Сформировать схемный проект. 
7. Сохранить содержимое окна схемного редактора. Файл получает 

расширение *.dsn и размещается в подкаталоге network. 
8. Результаты моделирования (графики, таблицы и т.п.) сохранить 

в файле с расширением *.dds. 
Далее приводится описание лабораторных работ, ориентированных 

на  изучение  спектральных характеристик типовых радиосигналов и 
способов их оценки, изучение принципов работы простейших детекто-
ров модулированных сигналов для различных видов модуляции, иссле-
дование характеристик  амплитудных и частотных детекторов при 
вариации параметров сигналов и элементов схемы. 



3 
 

Лабораторная работа №1. ИССЛЕДОВАНИЕ 
СПЕКТРАЛЬНЫХ ХАРАКТЕРИСТИК ПЕРИОДИЧЕСКИХ И 

НЕПЕРИОДИЧЕСКИХ СИГНАЛОВ  

 

1. Цель работы 

 

Формирование моделей периодических и непериодических сигна-
лов, исследование амплитудного и фазового спектра сигналов  с исполь-
зованием методов  решения системы дифференциальных уравнений,  
описывающих поведение схемы во временной области и прямого пре-
образования Фурье.   

 

2. Теоретическая часть 

 

Под сигналом S(t) будем понимать изменение во времени одного 
из параметров физического процесса. Классификация сигналов по ряду 
признаков отражена на рис.1.  

  

 
 

Рис.1. Классификация сигналов 
 

Детерминированным называется сигнал, который точно опреде-
лен в любой момент времени (например, задан в аналитическом виде). 
Детерминированные сигналы могут быть периодическими и непериоди-
ческими. 
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Периодическим называется сигнал, для которого выполняется 
условие:  

S(t) = S(t + кT), 
где к – любое целое число, Т – период, являющийся конечным от-

резком времени.  
Пример периодического сигнала - гармоническое колебание: 

)
2

cos()( 
 t

T
AtS  

Любой сложный периодический сигнал может быть представлен в 
виде суммы гармонических колебаний с частотами, кратными основной 
частоте ω=2π/T. 

Непериодический сигнал, как правило, ограничен во времени. 
Случайным сигналом называют функцию времени, значения ко-

торой заранее неизвестны и могут быть предсказаны лишь с некоторой 
вероятностью. В качестве основных характеристик случайных сигна-
лов принимают: 

а) закон распределения вероятности (относительное время пребы-
вания величины сигнала в определенном интервале); 

б) спектральное распределение мощности сигнала. 

Спектральный анализ периодических сигналов 

Известно, что любую функцию S(t), кусочно-непрерывную на ин-
тервале а < t < b и ограниченную по норме: 

 
b

a

dttS
2

)(  

можно разложить в ряд, называемый обобщенным рядом Фурье, 
по полному набору (базису) ортогональных функций Ψn(t):  

)()()()( 1100 tCtCtCtS nn  . 

Функции Ψk(t) называются ортогональными, если выполняется со-
отношение: 

 
b

a
dtt

k
t

m
0)()( , при m= к     

b

a
kkk dttt 2)()( – норма. 

Для комплексных функций Ψk(t), Ψk
*(t) есть комплекснo- сопря-

женная ей функция. Коэффициенты ряда определяются следующим 
выражением: 
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В радиотехнике в качестве базисных функций разложения Фурье 
используют преимущественно тригонометрические функции. Это объ-
ясняется следующими причинами: 

а) функции cosωt, sinωt являются простыми, определены при всех 
значениях t, являются ортогональными и составляют полный набор при 
кратном уменьшении периода; 

б) гармоническое колебание является единственной функцией 
времени, сохраняющей свою форму при прохождении колебания через 
линейную систему с постоянными параметрами, могут изменяться лишь 
амплитуда и фаза; 

в) для гармонических функций и их комплексного анализа имеется 
мощный математический аппарат, найдены спектры множества форм 
сигналов; 

г) гармоническое колебание легко осуществить на практике. 
Спектр периодического сигнала является дискретным и представ-

ляет набор гармонических колебаний, в сумме составляющих исходный 
сигнал. Одним из преимуществ разложения сигнала в спектр является 
следующее. Токи и напряжения в цепи под действием сигнала описы-
ваются дифференциальными уравнениями, соответствующими элемен-
там цепи и способу их соединения. Линейные цепи описываются ли-
нейными дифференциальными уравнениями, причем для линейных 
цепей верен принцип суперпозиции, согласно которому действие на 
систему сложного сигнала, состоящего из суммы простых сигналов, 
равно сумме действий от каждого составляющего сигнала в отдельно-
сти. Это позволяет при известной реакции системы на какой-либо про-
стой сигнал, например, на синусоидальное колебание с определенной 
частотой, определить реакцию системы на любой сложный сигнал, 
разложив его в ряд по синусоидальным колебаниям. 
 

Спектральный анализ непериодических сигналов 

Пусть задан сигнал в виде ограниченной во времени функции S(t), 
отличной от нуля в промежутке t1t2 как показано на рис.2.  



6 
 

 
Рис.2 Пример непериодического сигнала  

 

Выделим произвольный отрезок времени T, включающий проме-
жуток t1t2, далее продолжим аналитически S(t) на всю бесконечную ось 
с периодом T. Тогда мы сможем разложить такую периодическую 
функцию S(t) в гармонический ряд Фурье. В комплексной форме будем 
иметь: 
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Полученный ряд на участке [t1,t2] будет точно соответствовать 
нашей функции S(t). Однако, если нас интересуют моменты времени за 
участком [t1,t2], то необходимо увеличить период Т, т. е. отодвинуть 
повторные значения функции S(t). Производя замену переменных и 
переходя от суммирования к интегрированию, получим 

 d
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  )(S  - спектральная плотность сигнала S(t). 
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Спектр непериодического сигнала сплошной (непрерывный) и 
распространяется на отрицательные частоты. 

Если S(ω) = A(ω) + iB(ω), то 22)()( BASS    - модуль 

спектральной плотности  или амплитудно-частотная характеристика: 

 
)(

)(
)(




A

B
arctg - фазово-частотная характеристика. 

Необходимое условие существования спектральной плотно-

сти: 




dtts
2

)( . 

3. Задание 

 

3.1. Создать рабочий проект в среде САПР ADS или открыть име-
ющийся. 

3.2. Сформировать схемный проект, включающий последователь-
ное соединение  источника напряжения периодической последователь-
ности импульсов во временной области (компонента V_Pulse из группы 
Sources Time Domain) и 50-омного резистора. 

3.3. Установить имя выходного напряжения на узел соединения 
резистора и источника напряжения. 

3.4. Определить параметры источника напряжения V_Pulse (рис. 3, 
2) согласно заданному варианту последовательности прямоугольных 
импульсов: 

VtPulse
SRC1

Period=10 nsec
Width=3 nsec
Fall=1 nsec
Rise=1 nsec
Edge=linear
Delay=0 nsec
Vhigh=1 V
Vlow=0 V

t

 
Рис. 3. Задание параметров импульсного источника напряжения 

 
Vlow – нижний уровень импульсов; 
Vhigh – верхний уровень импульсов; 
Delay – время задержки ; 
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Edge – закон изменения переднего и заднего фронтов импульсов 
(linear – линейный); 

Rise – время нарастания переднего фронта импульсов; 
Fall – время спада заднего фронта импульсов; 
Width – ширина вершины импульсов. 

 

 
Рис. 4. Определение параметров импульсного источника 

 

В данном случае время задержки, нарастания и спада принять рав-
ными минимальному значению шага временного анализа, деленному на 
10-100  (см. ниже). 

3.5. Выбрать и разместить на схеме контроллер проведения анали-
за во временной области (компонента TRAN из группы Simulation 
Transient). Определить временные параметры анализа в диалоговом 
окне Time Setup размещенного контроллера: начальное время анализа 
Start time=0, конечное время анализа Stop Time, которое должно быть 
быть установлено равным  100 периодам входного сигнала; минималь-
ное значение шага анализа (min time step) может быть выбрано равным 
1/10 ширины самого узкого участка периода входного сигнала (умень-
шение этого параметра увеличивает точность анализа и его время). 
Минимальное значение шага анализа будет определять максимальную 
частоту рассчитываемого спектра. 

3.6. Запустить проект на анализ командой Simulation>Simulate. 
3.7. Вывести в окне просмотра выходных результатов временную 

развертку выходного напряжения и, при необходимости, локализовать 
ее в области наблюдаемых  процессов для более удобного наблюдения.  
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Вывести в окне просмотра выходных результатов компоненту Eqn 
и сформировать уравнение, реализующее функцию прямого преобразо-
вания Фурье fs(vout), где vout – имя выходного напряжения, присвоив 
его какому-либо идентификатору, например, SPECTR1 (рис. 5) 

Eqn SPECTR1=fs(out)

 
Рис. 5. Определение уравнения для выполнения Фурье-анализа 

 

Открыть окно построения графика в прямоугольной системе коор-
динат (Rectangle).   В окне Datasets and Equations  выбрать группу 
Equations, а в ней – имя сформированного уравнения (SPECTR1) и 
добавить его на график (Add), предварительно выбрав форму вывода 
амплитудного спектра – Magnitude. Разместить маркеры в оцениваемых 
частотных точках спектра. В результате сформируется изображение, 
приведенное на рис. 6. 

 
Рис. 6. Спектр периодической последовательности импульсов и временное 

изображение сигнала 
 

Выполнить оценку амплитуды  для произвольных двух гармоник 
спектра с помощью маркеров. 

Увеличивая и уменьшая период следования импульсов в два раза, 
получить временные развертки и амплитудные спектры. Наблюдать 
изменения спектра. 

3.8. Преобразовать источник прямоугольных импульсов в источ-
ник пилообразного сигнала. Для этого достаточно поменять местами 
значения длительности фронта нарастания и длительности вершины 
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импульса в источнике сигнала. Провести спектральный анализ при 
различных значениях периода. Наблюдать изменения спектра. Сравнить 
спектры прямоугольных и пилообразных сигналов. 

3.9. Восстановить параметры исходного источника прямоугольных 
импульсов.  Установить значение периода последовательности далеко 
за пределами времени проведения анализа, определенного  в контролле-
ре TRAN, моделируя тем самым эффект одиночного импульса. 

3.10. Выполнить спектральный анализ для двух различных значе-
ний длительности импульса. Вывести амплитудные спектры и времен-
ные развертки сигнала. Наблюдать изменения спектра. 

4. Содержание отчета 

 

4.1. Цель работы, задание. 
4.2. Теоретическая часть, включающая последовательность опре-

деления амплитудного спектра исходного сигнала в общем виде с коли-
чественной оценкой выбранных двух гармоник для сравнения в п. 2.10. 

4.3. Схемные проекты для проведения исследований с синусои-
дальным и импульсным источником и результаты моделирования. 

4.4. Полученные в ходе моделирования и рассчитанные графиче-
ские зависимости. 

4.5.  Выводы по результатам проведенных исследований. 

5. Контрольные вопросы и задания 

 

5.1. Спектральный анализ  периодических сигналов. Разложение в 
ряд Фурье.  

5.2. Применение формул прямого и обратного преобразования 
Фурье для непериодических сигналов  

5.3. Учет свойства четности и нечетности сигналов при спектраль-
ном анализе. 

5.4. Свойства преобразования Фурье (сдвиг во времени сигнала, 
сжатие-расширение сигнала). 

5.5. Свойства преобразования Фурье (дифференцирование и инте-
грирование колебаний). 

5.6. Свойства преобразования Фурье (дифференцирование и инте-
грирование колебаний). 
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5.7. Свойства преобразования Фурье (произведение колебаний). 
5.8. Свойства спектра последовательности прямоугольных им-

пульсов. 
5.9. Свойства дельта-функции. 
5.10. Формирование проекта для проведения спектрального анали-

за  предложенной схемы в среде САПР ADS. 
 

6. Варианты параметров сигналов 

Таблица 1. 
Номер 
варианта 

Верхний уровень 
сигнала, В 

Нижний уро-
вень сигнала, В 

Длительность 
вершины 

импульса, нс 

Период следова-
ния импульсов, нс 

1 1 0 200 800 
2 2 -2 100 800 
3 1 -2 500 1500 
4 4 2 100 400 
5 1 -4 400 1200 
6 2 1 200 1000 
7 0 -2 100 1000 
8 2 -4 200 1200 
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Лабораторная работа №2. ИССЛЕДОВАНИЕ СИГНАЛОВ С 
АМПЛИТУДНОЙ МОДУЛЯЦИЕЙ 

 

1. Цель работы 

 

Изучение и исследование временных и спектральных характери-
стик сигналов с амплитудной модуляцией (АМ); изучение принципов 
детектирования сигналов с АМ-модуляцией. 

    

2. Теоретическая часть 

 

Описание сигналов с амплитудной модуляцией 

 

В общем виде сигнал с амплитудной модуляцией (рис. 7) может 
быть описан следующим образом: 

)cos()()( 00   ttAta , 

где A(t) – модулирующий (управляющий) сигнал, 
cos(ω0t+θ0) – несущий сигнал(колебание), 
ω0 – частота несущего колебания, 
θ0 – начальная фаза несущего колебания. 
 

Глубина амплитудной модуляции - максимальное относительное 
отклонение амплитуды от среднего:  

minmax

minmax

22

22

AA

AA
M




 ,  

где   max min,A A - соответственно максимальное и минимальное зна-

чения модулированного сигнала (рис. 7). 

 
Рис.7. АМ-сигнал и оценка глубины модуляции 
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Определение спектра амплитудно-модулированного сигнала 

  

Спектральную плотность АМ-сигнала, представляющего собой 
произведение модулирующего и несущего сигналов, можно определить 
на основании интеграла свертки:  
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Таким образом, спектральная плотность модулированного сигнала 
представляет собой два спектра модулирующей функции, построенных 
относительно частот ω  =  ω0 и ω  =  -ω0 (сдвинутых на частоты несу-
щей),  как показано на рис. 8. 

 
Рис.8. Спектр информационного и АМ-сигналов в общем виде 

 

Пример определения спектра АМ-сигнала при гармоническом 
модулирующем сигнале 

 

В  случае гармонического модулирующего воздействия АМ-
сигнал может быть описан с помощью следующего выражения: 

),cos()cos()cos()( 000000   ttMAtAta где 

Ω -  частота модулирующего колебания, 
φ – начальная фаза модулирующего колебания. 
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Второе слагаемое может быть сведено к виду, используя тригоно-
метрические преобразования  

   0 0
0 0 0 0cos ( ) ) cos ( ) ) .

2 2

A M A M
t t                      Это выражение 

соответствует новым гармоническим колебаниям с частотами ω0 + Ω и 
ω0 - Ω, соответствующими верхней и нижней боковым частотам моду-
ляции. Зависимость модуля спектральной плотности от частоты приве-
дена на рис. 9. 

 

Рис. 9. Спектральная плотность АМ –сигнала при однотональной модуляции 
  

Амплитудное детектирование 

Амплитудный детектор состоит из нелинейного элемента и низко-
частотного фильтра в качестве нагрузки. На вход детектора подается 
модулированный сигнал ttEte 0cos)()(  . На выходе детектора генериру-

ется сигнал E(t). Различают 2 способа детектирования АМ сигнала – 
квадратичный и линейный. 

Квадратичное детектирование осуществляется при малой ампли-
туде сигнала, полностью укладывающемся на нижнем квадратичном 
участке вольтамперной характеристики нелинейного элемента, напри-
мер,  полупроводникового диода (рис. 10). 

 
Рис.10. Пример схемы детектора АМ-сигналов на биполярном транзисторе 
и отклик нелинейного элемента при квадратичном детектировании 

 

В этом случае выходной ток нелинейного элемента можно запи-
сать следующим образом: 



15 
 

)()()()( 2

210 teateaUItI  . 

 ttEattEaUItI 0

22

2010 cos)(cos)()()(   

22

0

22

010 2
2cos)(

2
cos)( E

a
ttE

a
ttEaI   . 

Высокочастотные составляющие ω0 и 2ω0 отфильтровываются. 
Информация содержится в последнем низкочастотном слагаемом. 
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1 2

2 tEaI  при условии 

0

22







RC .  

Следует заметить, что если вывести напряжение смещения U0 на 
линейный участок вольт-амперной характеристики, то детектирования 
вообще не будет. Рассмотрим случай тональной модуляции, когда АМ-
сигнал представляется в виде: 

)cos1()( 0 tMEtE  . 

В этом случае: 
2 2 22

0

2 2
22

0

(1 2 cos cos )
2

(1 2 cos cos 2 )
2 2 2

a
I E M t M t

a M M
E M t t

     

    
. 

Как видно, при квадратичном детектировании появляется паразит-
ная двойная частота. При модуляции несколькими частотами возникают 
еще комбинированные частоты с амплитудами, пропорциональными 
произведению индексов модуляции (М1М2 ). Для уменьшения амплитуд 
высших комбинационных гармоник, нужно уменьшать глубину моду-
ляции М. Если требуется неискаженное воспроизведение сигналов 
(музыка), то квадратичное детектирование применять нецелесообразно. 

Линейное детектирование осуществляется при большой амплитуде 
сигнала при кусочно-линейной аппроксимации детектора (рис. 11). 

Когда речь идет о линейном детектировании, не следует, конечно, 
упускать из виду то, что детектор, работающий с отсечкой тока, являет-
ся сугубо нелинейным устройством. Эта нелинейность обусловлена 
формой характеристики не только в области u >0 (где характеристика 
может быть близка к линейной), а на протяжении всей области действую-
щих на диоде напряжений. При работе с отсечкой характеристика диода 
представляет собой ломаную линию, состоящую из участка оси абсцисс 
(при u < 0) и наклонной линии (при u > 0), с изломом вблизи точки и = 
0. 
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Рис.11. Отклик нелинейного элемента на АМ-сигнал при линейном детекти-

ровании 
Режим модуляции накладывает на выбор элементов нагрузки де-

тектора дополнительные ограничения. Необходимо,   чтобы  постоянная 
времени цепи нагрузки была мала по сравнению с периодом модуляции. 
В противном случае изменение выпрямленного напряжения на нагрузке 
может отставать от изменения огибающей входной э.д.с. Подобный 
режим представлен на рис. 12. На участке а — б из-за чрезмерно большой 
инерционности RC-цепи напряжение uвых отстает в своем росте от огиба-
ющей э.д.с. В точке б, где uвых и амплитуда модулированной э.д.с. урав-
ниваются, ток через диод и рост uвых  прекращаются. На участке б —в 
источник э.д.с. и диод не оказывают никакого влияния на нагрузочную 
цепь и в последней происходит разряд конденсатора С через резистор R. 
Таким образом, на участке б - в  напряжение является экспонентой. Полу-
чается нелинейное искажение сигнала. Так как эти искажения обусловле-
ны тесным взаимодействием нелинейного элемента (диод, транзистор) с 
линейной цепью (RC), степень нелинейных искажений зависит не только 
от параметров цепи и глубины модуляции, но также и от частоты модуля-
ции. Эти искажения возрастают с повышением частоты, а также глубины 
модуляции входной э. д. с.. Для устранения рассматриваемых искажений 
необходимо, чтобы выполнялось неравенство R·C<<2π/Ω. С другой 
стороны, для сглаживания высокочастотных пульсаций требуется выпол-
нение неравенства R·C>>2π/ω0. Совмещая эти два условия, получаем 
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неравенство, определяющее условие неискаженной передачи информа-
ционного сигнала: 

 
2π/ω0<<R·C<<2π/Ω. 

 

 
Рис. 12. Случай правильного (а) и неправильного (б) выбора параметров RC-

нагрузки АМ-детектора 
 

Обычно частоты ω0 и Ω сильно различаются (Ω << ω0) и выполнение 
условия не встречает затруднений. 

При импульсной модуляции огибающей в правой части неравен-
ства вместо периода модуляции 2π/Ω следует подставлять длительность 
импульса. При этом предполагается, что интервалы между импульсами 
велики по сравнению с длительностью импульса. При очень коротких 
импульсах, длительность которых всего лишь в несколько раз превыша-
ет период Т0 = 2π/ω0 («высокочастотный голод») возникают трудности с 
разделением огибающей и высокочастотного заполнения. 

 

3. Задание 

 

3.1. Создать проект САПР ADS в рабочем каталоге. Установить 
аналоговый режим работы системы (команда главного меню Tools>ADS 
Setup>Analog RF only.  
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3.2. Подготовить схемный проект для проведения анализа источ-
ника АМ-сигнала во временной области при синусоидальном модули-
рующем сигнале. Установить индекс модуляции m= 0,5. Выполнить 
анализ на интервале 5 – 10 периодов модулирующего сигнала.  

3.3. Вывести временную развертку АМ-сигнала на выходе модуля-
тора и с помощью маркеров и уравнения определить экспериментально 
значение глубины модуляции. 

3.4. Выполнить спектральный анализ выходного сигнала. Вывести 
амплитудный и фазовый спектр АМ-сигнала, локализованный в окрест-
ности несущей частоты. С помощью маркеров определить амплитуды и 
фазы всех спектральных составляющих. 

3.5. Повторить анализ п. 3.3 для значений индекса модуляции 0,9 и 
0,2. 

3.6. Включить на модулирующий вход источник импульсного сиг-
нала типа меандр и определить временную развертку и спектр АМ-
сигнала при m=0,5. Частота следования прямоугольных импульсов 
должна соответствовать частоте синусоидального источника. Выпол-
нить  анализ и определить временную развертку и спектр АМ-сигнала. 
Уменьшить ширину импульса  в 10 раз и повторить анализ. 

3.7. Сравнить спектры сигналов (ширина, форма, амплитуда) в 
первом и во втором случаях. 

3.8. Сформировать схемный проект модели детектора АМ-
сигналов, включив в нее амперметр последовательно    с диодом. Уста-
новить параметры выходного RC-фильтра. Выполнить анализ. 

3.9. Вывести на экран временные развертки выходного сигнала, 
тока через диод. Выполнить спектральный анализ выходного сигнала и 
определить коэффициент нелинейных искажений  по формуле: 

2 2 2 2 2 2 2
2 3 4 1 2 3 4( ...) /( ...)Кг V V V V V V V        , где  

iV - гармоники амплитудного спектра выходного сигнала. 

3.10. Увеличивать и уменьшать  в 50 раз емкость или сопротивле-
ние выходного фильтра и определять  временную развертку выходного 
сигнала и коэффициент нелинейных искажений. Объяснить возможные 
причины изменения качества  продетектированного сигнала. 

3.11. Путем многовариантного анализа определить наиболее оп-
тимальное значение параметров RC-цепи (менять R или C), при котором 
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будет зафиксировано минимальное значение коэффициента нелинейных 
искажений. Расчеты провести для 6-ти точек изменения и фиксировать 
только значение Кг. 

3.12. Включить импульсный источник сигнала типа меандр с ча-
стотой, соответствующей частоте синусоидального источника и опреде-
лить временную развертку сигнала на выходе детектора при индексе 
модуляции 0,5 и 1 . 

3.13. Включить на выходе детектора последовательно-
параллельную RC-цепочку с параметрами С=100 нФ, R=50 кОм. Опре-
делить временную развертку напряжения на сопротивлении R=50 кОм и 
убедитель в отсутствии постоянной составляющей. При необходимости 
для достижения установившегося режима увеличьте интервал анализа в 
контроллере TRAN.  

 

4. Пример выполнения задания 

 

4.1 Формирование проекта для проведения исследований АМ-
сигнала во временной области при  гармоническом модулирующем 

сигнале 

 

На рис.13 приведена схема проекта для проведения анализа.  
 

 
Рис. 13. Схемный проект для проведения исследований источника АМ-

сигнала при гармоническом  модулирующем сигнале 
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В состав проекта включены следующие основные компоненты: 
MOD1  – модулятор, генерирующий АМ-сигнал. Компонента 

AM_ModTuned  находится в группе System – Mod/Demod. Параметры 
компонента: ModIndex – индекс модуляции, Fnom – частота несущего 
сигнала, Rout – выходное сопротивление. Ко входу RF in подключается 
гармонический источник несущего сигнала, ко входу MOD IN – источ-
ник модулирующего сигнала. Модулированный сигнал генерируется на 
выходе RF out. В данном случае нагрузкой является сопротивление 50 
Ом, а для съема информации используется выходное напряжение с 
установленным именем Vout.  

SRC1 – источник синусоидального несущего сигнала. Компонента 
VtSine находится в группе Sources_Time_Domain. Параметры компо-
нента: Amplitude – амплитуда  сигнала (принять 1 В), Freq – частота 
сигнала.  

SRC2 – источник модулирующего синусоидального сигнала.        
Установить для проведения исследований  амплитуду 1 В. В данном 
примере установлено значение частоты модуляции 1 кГц.   

В контроллере Tran определить конечное время анализа (несколь-
ко периодов модулирующего сигнала) и максимальный шаг, размер 
которого определить значением не более 1/20 периода несущего сигна-
ла.  

Выполнить моделирование. 
 

4.2 Определение временных и спектральных характеристик 
АМ-сигнала 

 

Активизировать окно просмотра выходных результатов (напряже-
ние Vout). Вывести временную зависимость выходного сигнала  моду-
лятора. На развертке установить маркеры в локальных максимумах и 
минимумах огибающей, как показано на рис. 14. 
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Рис. 14. Временная развертка АМ-сигнала. 

 

С помощью компонента Eqn сформировать уравнение для опреде-
ления глубины модуляции (рис. 15). После этого, используя табличную 
форму визуализации данных (тип List), вывести рассчитанное значение, 
которое находится в блоке выходных данных  (см. окно приложения 
List) Datasets and Equations>Equations>M .  

 
Рис. 15. Определение глубины модуляции 

 

Сформировать уравнение для спектрального анализа с помощью 
разложения выходного отклика в ряд Фурье с применением функции 
fs() (рис. 16). 

 

Рис. 16. Уравнение для спектрального анализа напряжения Vout 
 

В данном уравнении рекомендуется  для более удобного вывода 
спектра установить  интервал Фурье-анализа (начальное и конечное 
время), соответствующий периоду АМ - сигнала ( 1 и 2 мС соответ-
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ственно) на последнем интервале проведенного временного анализа, что 
позволит миновать возможные переходные процессы. Если переходных 
процессов не удается избежать, необходимо увеличить время анализа и 
повторить моделирование. Если точное значение периода установить 
сложно, то нужно  использовать функцию fs() только с параметром 
Vout. Если заданное значение максимального шага анализ не соответ-
ствует временным изменениям сигнала то программа  выбирает его 
значение  в автоматическом режиме. Выбранный шаг генерируется в 
окне статуса после запуска проекта на моделирование и будет прини-
маться во внимание.  

Вывести амплитудный и фазовый спектры  напряжения Vout (оп-
ции Magnitude и Phase), затем локализовать их в окрестности несущей 
частоты и установить маркеры на реальных спектральных составляю-
щих, как показано на рис. 17 -  18. 

 

 
Рис.17. Амплитудный спектр АМ-сигнала. 
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Рис. 18. Фазовый спектр АМ-сигнала 

4.3 Формирование проекта для проведения исследований АМ-
сигнала во временной области при  импульсном модулирующем 

сигнале 

Схема проекта приведена на рис. 19. 

 
Рис. 19. Схемный проект с импульсным модулирующим сигналом 

 

На рис. 20 приведены временная развертка сигнала, уравнение для 
Фурье-анализа и амплитудный спектр в dB. Маркеры определяют при-
близительно ширину спектра. В данном случае базовая (минимальная) 
частота в преобразовании Фурье определяется интервалом анализа, 
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установленным в контроллере Tran по формуле Fo=1/(StopTime). Мак-
симальная частота определяется интервалом анализа по формуле: 

Fмакс=1/(2*MaxTimeStep). 
Если заданное значение максимального шага анализа не соответ-

ствует временным изменениям сигнала, то программа  выбирает его 
значение  в автоматическом режиме. Выбранный шаг генерируется в 
окне статуса после запуска проекта на моделирование и будет прини-
маться во внимание при определении значения Fмакс. 

 

 
Рис. 20. Временная и спектральная характеристики АМ-сигнала при моду-

ляции последовательностью импульсов 
После вывода спектра можно локализовать его в окрестности не-

сущей частоты, как описано в п. 3.2. 
 

4.4 Формирование проекта для проведения исследований АМ-
сигнала во временной области при  импульсном модулирующем 

сигнале. Оценка основных характеристик 

 

Схема проекта приведена на рис. 21. 
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Рис. 21. Схемный проект детектора АМ-сигналов 

 

В этом проекте необходимо разместить компоненты диода и его 
модели (Diode и Diode_Model), которые находятся в группе Devic-
es_Diodes, и амперметра I_Probe из группы Probe Components. 

На рис. 22 - 23 приведены временные развертки тока через диод в 
различных масштабах времени. На рис. 24 показана временная замиси-
мость напряжения   на выходе детектора. 

 
Рис. 22. Временная зависимость тока через диод на всем анализируемом 

интервале времени 

 
Рис. 23. Временная зависимость тока через диод в узком интервале времени 
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Рис. 24 Временная развертка напряжения на выходе детектора 

 
Уравнение для проведения Фурье-анализа и амплитудный спектр 

приведены на рис. 25. Маркеры установлены на первых трех гармони-
ках спектра. 

 
Рис. 25. Определение амплитудного спектра выходного напряжения 

 

На рис. 26 приведено уравнение и результаты расчета коэффици-
ента нелинейных искажений по установленным на рис. 20 маркерам. 

 
Рис. 26. Определение коэффициента нелинейных искажений 
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5. Содержание отчета 

 
5.1. Цель работы, задание. 
5.2. Теоретическая часть, включающая описание основных харак-

теристик АМ - сигналов и принципов работы простейшего детектора 
АМ-сигналов. 

5.3. Схемные проекты для проведения исследований. 
5.4. Полученные в ходе моделирования и рассчитанные графиче-

ские зависимости. 
5.5. Выводы по каждому пункту проведенных исследований. 
 

6. Контрольные вопросы 

 
6.1. Выполните математическое описание АМ-сигнала. Дайте 

определение индексу модуляции и способам его определения. Какие 
факторы влияют на выбор несущей частоты?  

6.2. Определите спектр АМ-сигнала для произвольного  сигнала.  
6.3. Определите спектр АМ-сигнала при однотональной модуля-

ции. 
6.4. Каково должно быть соотношение частот несущего и модули-

рующего сигналов? 
6.5. Принцип работы детектора АМ-сигнала. 
6.6. Объясните назначение RC-цепи на выходе детектора и прин-

ципы выбора ее параметров. 
6.7. К каким последствиям  может привести увеличение частоты 

модуляции или уменьшение несущей частоты. 
6.8. Почему на выходе детектора присутствует постоянная состав-

ляющая напряжения  и как от нее избавиться. 
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7. Варианты параметров сигналов и элементов схемы 

Таблица 2 
Номер 
варианта 

Частота несу-
щей, МГц 

Частота моду-
ляции, кГц 

Значение 
резистора, 

кОм 

Значение емко-
сти, нФ 

1 1 2 2 1 
2 2 10 1 1 
3 0,5 0,5 1 2 
4 4 20 2 0,5 
5 1 10 4 1 
6 2 1 2 2 
7 0,5 1 2 4 
8 2 5 2 1 
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Лабораторная работа №3. ИССЛЕДОВАНИЕ СИГНАЛОВ С 
ЧАСТОТНОЙ МОДУЛЯЦИЕЙ  

 

1. Цель работы 

 

Изучение и исследование временных и спектральных характери-
стик сигналов с частотной модуляцией (ЧМ); изучение принципов де-
тектирования ЧМ-сигналов.    

 

2. Теоретическая часть 

 

Частотно модулированное колебание можно записать в следую-
щем виде: 





  

t

dttAta
0

00 )(cos)(  ,  ω(t) = ω0 + ks(t), где 

A0 – амплитуда модулированного колебания, 
ω0 – несущая частота, 
s(t) – модулирующее колебание, 
k – коэффициент, 
θ0 – начальная фаза. 
Девиация частоты – максимальное отклонение частоты от ча-

стоты несущего колебания, т.е. ωд = ωmax – ω0. Будем считать, что моду-
лирующий сигнал является гармонической функцией тогда: 

)cos()( 0 tt д   , 

где Ω – частота модулирующего сигнала. 
В этом случае ЧМ – сигнал можно записать в следующем виде: 

0 0 0 0 0

0

0 0 0 0

( ) cos ( cos( )) cos(

sin( ) ) cos( sin( ) ),

t

д

д

a t A t dt A t

t A t m t

  

 

 
      

 

     



 

где m =ωд/Ω – индекс модуляции. 
Таким образом, индекс модуляции ЧМ - сигнала представляет со-

бой максимальное отклонение фазы. 
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Для неискаженной передачи сообщения необходимо, чтобы шири-
на спектра сообщения была мала по сравнению с несущей ω0, а для 
этого необходимо, чтобы относительное изменение модулирующей 
функцией ω(t) было мало за один период  несущего колебания T: 

T

t

dt

td )()( 
 . 

Спектр ЧМ – сигнала 

Рассмотренный выше ЧМ сигнал можно считать частным случаем 
сигнала с угловой модуляцией. 

))(cos()( 00 ttAta   , 

Преобразуем косинус суммы: 
 ttAttAta 0000 sin)(sincos)(cos)(   . 

)(sin),(cos 00 tAtA  - медленно изменяющиеся амплитуды. 

Итак, ЧМ – сигнал можно рассматривать как сумму двух ампли-
тудно-модулированных колебаний (квадрупольных). Для определения 
спектра каждого из них достаточно сдвинуть на ω0 спектр огибающих 
амплитуд, т.к. cosθ(t) и sinθ(t) являются нелинейными функциями своего 
аргумента θ(t), то спектры этих функций могут существенно отличатся 
от спектра модулирующей функции S(t) и при однотональной модуля-
ции возможно возникновение кратных и комбинированных частот. 
Однако при малых индексах модуляции (m<<1) можно положить 
θ(t)=cosΩt, tmtt  cos)()(sin  , тогда 

0 0 0 0 0 0

0 0

( ) cos cos sin cos

sin( ) sin( )
2 2

m m

a t A t A m t t A t

A A
t t

  

 

    

  
, 

т.е. спектр, как и в случае с амплитудной модуляциией, состоит из 
несущей и двух боковых частей (но сдвинутых по фазе), а ширина спек-
тра приближенно равна 2Ω. 

Но при больших индексах модуляции (m>>1) за счет появления 
новых гармоник спектр расширяется и ширина спектра равна 2mΩ=2ωд. 
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       S(ω)                                       S(ω)                                           S(ω) 
          m<<1                                     m=1                                          m>>1                                                                         

 
 
 

 
 

Рис. 27. Модуль спектральной плотности ЧМ-сигнала при различных значе-
ниях индекса модуляции 

 

 Частотное и фазовое детектирование 

 

Напряжение на выходе частотного детектора должно воспроиз-
водить закон изменения мгновенной частоты модулированного ко-
лебания. Представив последнее в форме 

 0 0( ) cos ( )e t E t t   , 

получим для идеального частотного детектора следующую функциональную связь: 

)()( tS
dt

d
Stu ЧДЧДвых 

 , 

где SЧД = const — крутизна характеристики детектора, выраженная 
в вольтах на единицу угловой частоты;  

dt

d
t

  )( - мгновенное значение частотного отклонения входной 

э. д. с. Если пользоваться частотами / 2f   , то в выражении 

)()( tfStu ЧДвых   

крутизна характеристики SЧД будет иметь размерность В/Гц. 
Предполагается, что  Δf(t), а следовательно, и uвых(t) являются 

«медленными» функциями времени. Для выделения сообщения из частот-
но-модулированного колебания, спектр которого состоит только из 
высокочастотных составляющих (несущая частота и боковые частоты 
модуляции), необходимо нелинейное устройство. Следовательно, частот-
ный детектор обязательно должен включать в себя нелинейный элемент. 
Однако в этом случае в отличие от амплитудного детектора для образо-
вания частот сообщения одного лишь нелинейного элемента недостаточ-
но. Действительно, из вольт-амперных характеристик нелинейных эле-
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ментов видно, что при постоянстве амплитуды входного напряжения 
нелинейный элемент не реагирует на изменение частоты этого напря-
жения. Иными словами, нелинейность таких устройств, как диод, прояв-
ляется лишь при изменении величины действующего на них напряжения, 
а не при изменении частоты или в общем случае скорости изменения 
сигнала. Поэтому обычный частотный детектор представляет собой соче-
тание двух основных частей: 1) избирательной линейной цепи, пре-
образующей частотную модуляцию в амплитудную и 2) амплитудного 
детектора.  

При правильном построении схемы частотного детектора изме-
нение амплитуды входного сигнала не должно влиять на величину вы-
ходного напряжения. Поэтому в схему частотного детектора обычно 
входит устройство для ограничения амплитуды входной э. д. с. Иногда 
ограничение осуществляется уста- 

новлением специального режима работы усилительного прибора, 
входящего в состав частотного детектора. 

В качестве линейной цепи можно использовать любую электри-
ческую цепь, обладающую неравномерной частотной характеристикой: 
цепи RL, RC, фильтры, колебательные контуры и т. д. В высокочастотной 
технике большое распространение получили колебательные цепи. Схе-
ма частотного детектора, содержащего простой колебательный контур, 
представлена на рис. 28. В данной схеме транзистор предотвращает 
шунтирование входным  источником напряжения e(t)  колебательного 
контура. В идеальном случае на модельных задачах можно использо-
вать источник тока в качестве модулирующего воздействия, упрощая 
схему детектора.   Если резонансная частота контура ωр отличается от 
средней частоты модулированного колебания ω0, то изменение амплитуды 
напряжения на контуре Uк повторяет в известных пределах изменение 
частоты входного напряжения, как показано на рис. 29. 

Рис. 28. Схема частотного детектора 
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Изменение амплитуды Uк, высокочастотного напряжения на кон-
туре с помощью диода Д преобразуется в низкочастотное напряжение, 
которое выделяется на  нагрузке R,C (рис. 29). Отметим попутно, что 
при точной настройке контура на частоту ωр = ω0 сигнал искажается; ча-
стота изменения огибающей получается вдвое выше частоты полезной 
модуляции. В исходном режиме, т. е. при отсутствии модуляции, рабочая 
точка должна устанавливаться на скате резонансной кривой. 

Недостатком рассмотренной схемы является необходимость на-
стройки контура на частоту, отличную от частоты немодулированного 
колебания. Кроме того, одиночный колебательный контур имеет весьма 
ограниченный линейный участок на скате резонансной кривой. Поэтому 
на практике, как правило, применяют более сложные схемы детектиро-
вания.  

 

 
Рис. 29. Принципы преобразования ЧМ-сигнала в АМ-сигнал 

 

3. Задание 

 

3.1. Создать проект САПР ADS в рабочем каталоге. Установить 
аналоговый режим работы системы (команда главного меню Tools>ADS 
Setup>Analog RF only).  

3.2. Подготовить схемный проект для проведения анализа источ-
ника ЧМ-сигнала во временной области при синусоидальном модули-
рующем сигнале заданной частоты. Установить индекс модуляции m= 
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10. Выполнить анализ на интервале 5 – 10 периодов модулирующего 
сигнала. Вывести временную развертку ЧМ-сигнала на выходе модуля-
тора и с помощью маркеров наблюдать изменение частоты (периода) 
сигнала на некотором интервале анализа. 

3.4. Выполнить спектральный анализ выходного сигнала. Вывести 
амплитудный  спектр ЧМ-сигнала, локализованный в окрестности не-
сущей частоты. С помощью маркеров определить ориентировочно 
полосу модулированного сигнала по максимальным значениям ампли-
тудного спектра.  

3.5. Повторить анализ п. 2.2 , 2.4 для значений индекса модуляции, 
равных 20, 1, 0,1, 0,01. Наблюдать за изменением полосы сигнала и его 
мощности (лучше всего – в dB). 

3.6. Сформировать схемный проект модели детектора ЧМ – сигна-
лов для проведения частотного анализа. Установить параметры выход-
ного RC-фильтра. Установить исходные параметры колебательного 
контура, указанные в примере, и источник переменного тока на входе 
детектора. С помощью многовариантного частотного  анализа опреде-
лить такие параметры (L, C) колебательного контура, при которых 
частота несущего сигнала будет находиться приблизительно посередине 
резонансной характеристики напряжения на контуре. Полученные зна-
чения использовать в дальнейших исследованиях. 

3.7. Подготовить проект для анализа ЧМ-детектора в режиме про-
хождения модулированных сигналов методами анализа во временной 
области.  Установить значение индекса модуляции, равное 10. 

3.8. Вывести на экран временные развертки выходного сигнала. 
Выполнить спектральный анализ выходного сигнала и определить ко-
эффициент нелинейных искажений  по формуле 

2 2 2 2 2 2 2
2 3 4 1 2 3 4( ...) /( ...)НИК V V V V V V V        , где iV - гармоники амплитудного 

спектра выходного сигнала. 
3.9. Повторить анализ п.2.7-2.8 при индексах модуляции, равных 

20, 1, 0,1, 0,01. Построить графики зависимости коэффициента нели-
нейных искажений и амплитуды выходного сигнала от индекса модуля-
ции. 

3.10. Повторить анализ п.2.7-2.8 при значениях частоты несущего 
сигнала, смещенной на 20% выше и ниже заданного значения при m=10. 
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3.11. Меняя частоту модулирующего сигнала от 1 до 20 кГц и 
определяя амплитуду первой гармоники выходного сигнала рассчитать 
амплитудно-частотную характеристику ЧМ-детектора. Принять m=10.   

 

4. Пример выполнения задания 

 

4.1 Формирование проекта для проведения исследований ЧМ-
сигнала во временной области при  гармоническом модулирующем 

сигнале 

 

На рис. 30 приведена схема проекта для проведения анализа.  

 
Рис. 30. Схемный проект для проведения исследований источника ЧМ-

напряжения  при гармоническом  модулирующем сигнале. 
 

   В состав проекта включены следующие основные компоненты: 
VtSFFM  – источник напряжения, генерирующий ЧМ-сигнал. 

Компонента   находится в группе Sources_Time_Domain. Параметры 
компонента: ModIndex – индекс модуляции, CarrierFreq – частота 
несущего сигнала, Amplitude – амплитуда несущего сигнала, Sig-
nal_Freq – частота модулирующего сигнала.. В данном случае нагруз-
кой является сопротивление 50 Ом, а для съема информации использу-
ется выходное напряжение с установленным именем Vout.  

В контроллере Tran определить конечное время анализа (несколь-
ко периодов модулирующего сигнала) и максимальный шаг, размер 
которого определить значением не более 1/20 периода несущего сигна-
ла.  

Выполнить моделирование. 
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4.2 Определение временных и спектральных характеристик 
ЧМ-сигнала 

Активизировать окно просмотра выходных результатов (напряже-
ние Vout).  

Вывести временную зависимость выходного сигнала  модулятора 
(рис. 31). На развертке установить маркеры в локальных максимумах  
огибающей и оценить изменение частоты несущей.  

 
Рис. 31. Временная развертка ЧМ-сигнала 

Сформировать уравнение для спектрального анализа с помощью 
разложения выходного отклика в ряд Фурье с применением функции 
fs() (рис. 32) и определить амплитудный спектр и полосу частот, зани-
маемую ЧМ-сигналом. 

 

 
Рис. 32. Амплитудный спектр ЧМ-сигнала 



37 
 

 

Если заданное значение максимального шага анализа не соответ-
ствует временным изменениям сигнала то программа  выбирает его 
значение  в автоматическом режиме. Выбранный шаг генерируется в 
окне статуса после запуска проекта на моделирование и будет прини-
маться во внимание при расчете спектра.  

 
 

4.3 Формирование проекта для определения параметров 
колебательного контура ЧМ-детектора методами частотного 

анализа. Результаты расчета амплитудно-частотных характеристик 
напряжения на контуре 

 

Схема проекта приведена на рис. 33. В этом проекте необходимо 
разместить компоненты диода и его модели (Diode и Diode_Model), 
которые находятся в группе Devices_Diodes. Определить имя напряже-
ния на контуре Vout_contur и напряжение на выходе детектора Vout. 

 
Рис. 33. Схемный проект для определения резонансной характеристики ко-

лебательного контура ЧМ-детектора 
 

Результаты расчета амплитудно-частотной характеристики (АЧХ) 
напряжения на контуре Vout_contur приведены на рис. 34. Из него 
видно, что выделенный маркерами участок характеристики соответ-
ствует наиболее оптимально частоте несущей 1,088 МГц. 
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Рис. 34. АЧХ напряжения на контуре  

 
4.4 Формирование проекта и результаты оценки временных и спектральных 

характеристик  выходного сигнала ЧМ-детектора.  
 

Схема проекта приведена на рис. 35. Временная развертка выход-
ного сигнала приведена на рис. 36. С помощью маркеров можно убе-
диться в том, что период соответствует частоте модулирующего сигна-
ла. 

 

 
Рис. 35. Схемный проект детектора ЧМ-сигналов 
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Рис. 36. Временная развертка напряжения на выходе детектора 

 

Уравнение для проведения Фурье-анализа, амплитудный спектр и 
результаты расчета коэффициента нелинейных искажений приведены на 
рис. 37. Маркеры установлены на первых трех гармониках спектра. 

 
Рис. 37. Определение амплитудного спектра выходного напряжения и ко-

эффициента нелинейных искажений 
 

5. Содержание отчета 

 

5.1. Цель работы, задание. 
5.2. Теоретическая часть, включающая описание  ЧМ-сигналов и 

принципов работы простейшего детектора ЧМ-сигналов. 
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5.3. Схемные проекты для проведения исследований. 
5.4. Полученные в ходе моделирования и рассчитанные графиче-

ские зависимости. 
5.5. Выводы по каждому пункту проведенных исследований. 

6. Контрольные вопросы 

 

6.1. Выполните математическое описание ЧМ-сигнала. Дайте 
определение индексу модуляции и частоте девиации. Какие факторы 
влияют на выбор несущей частоты.  

6.2. Выполните математическое описание ФМ-сигнала. Дайте 
определение индексу модуляции. Какие факторы влияют на выбор 
несущей частоты.  

Приведите примеры сигналов АМ и ЧМ. Постройте их временные 
зависимости. 

6.3. Определите спектр ЧМ-сигнала для случая однотональной мо-
дуляции при большом значении индекса модуляции.  

6.4. Определите спектр ЧМ-сигнала при однотональной модуля-
ции при малом значении индекса модуляции. 

6.5. Принцип работы детектора ЧМ-сигнала. 
6.6. Объясните назначение колебательного контура в ЧМ-

детекторе и принципы выбора ее параметров. 
 

7. Варианты параметров сигналов и элементов схемы 

Таблица 3 
Номер 
варианта 

Частота несущей, 
МГц 

Частота моду-
ляции, кГц 

Значение 
резистора, 

кОм 

Значение 
емкости, нФ 

1 1 2 2 5 
2 2 4 1 5 
3 2 0,5 1 10 
4 4 10 2 2 
5 1 1 4 1 
6 2 1 2 2 
7 0,5 0,5 2 4 
8 2 5 2 2 
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